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Nokia is a registered trademark of Nokia Corporation, Finland.
Windows CE is a registered trademark of Microsoft Corporation.
Other products may be trademarks or registered trademarks of their respective
manufacturers.
Copyright  1999. Nokia Mobile Phones Ltd. All rights reserved.
Nokia Mobile Phones operates on a policy of continuous improvement. Therefore we reserve the right to make changes
and improvements to any of the products described in this guide without prior notice.
Nokia Mobile Phones is not responsible for any loss of data, income or any consequential damage howsoever caused.
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For your safety

Read these simple guidelines. Breaking the rules may be dangerous or illegal.
Further detailed information is given in this manual.

ROAD SAFETY COMES FIRST
Do not use the Nokia Card Phone while driving; park the vehicle first.

INTERFERENCE
All wireless phones may get interference which could affect performance.

POWER DOWN IN HOSPITALS
Follow any regulations or rules. Switch phone off near medical equipment.

POWER DOWN IN AIRCRAFT
Wireless phones can cause interference. Using them on aircraft is illegal.

POWER DOWN WHEN REFUELLING
Do not use phone at a refuelling point. Do not use near fuel or chemicals.

POWER DOWN NEAR BLASTING
Do not use phone where blasting is in progress. Observe restrictions, and follow any regulations or rules.

USE SENSIBLY
Do not touch the antenna unnecessarily.

USE QUALIFIED SERVICE
Only qualified service personnel must install or repair equipment.

ACCESSORIES
Use only approved accessories. Do not connect incompatible products.

MAKE BACKUP COPIES
Remember to make backup copies of all important data.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.
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Introduction

This is the user’s manual for the Nokia Card Phone software for Windows CE. The software and the card phone enable
you to send and receive data, faxes and short messages using a handheld personal computer (HPC). This manual
includes the system overview and instructions for installing and using the Nokia Card Phone software.

Terms, acronyms and abbreviations

HPC Handheld PC
NCP Nokia Card Phone
Inbox Standard Windows CE mail client
SIM Subscriber Identity Module
PIN Personal Identifying Number
PUK Personal Unblocking Key
SMS Short Message Service
SMSC Short Message Service Centre
Windows CE Microsoft’s operating system for consumer devices
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System overview

The Nokia Card Phone is a PC Card (PCMCIA) based solution for sending and receiving data, faxes and short messages
using a Windows CE based handheld PC and the Nokia Card Phone software. The Nokia Card Phone software for
Windows CE includes a device driver for the phone and a simple monitoring utility which is used to control and
monitor the phone’s functions. You can see the figures of the Nokia Card Phone and a typical handheld PC below.

Integrated antenna (turnable helix),
connector for external antenna

Extended part holds
large SMD components

PCMCIA connector

Dimensions (length x width x thickness):
124 x 54 x 10.5 mm (antenna in low pos)

SIM card slot

Figure 1 Nokia Card Phone

Figure 2 Handheld PC
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Installation

System requirements

• Desktop PC running Windows 95/98 or Windows NT 4.0 with Service Pack 3

• 3.5” disk drive in the desktop PC

• Windows CE Services must be installed in the desktop PC. (The application comes with Windows CE)

• Handheld PC running Windows CE version 2.0 or higher

• PC Card slot in the handheld PC

• One serial port available both in the desktop PC and in the handheld PC

• Nokia Card Phone

Installation procedure

1. Connect the HPC to the serial port of the desktop PC. Windows CE Services establishes the data connection.

2. Insert the NCP software installation disk into the disk drive of the desktop PC.

3. Run the setup.exe that is in the installation disk.

4. Start the installation by pressing the Setup button. The ‘Application Manager’ window appears and on the top of
it appears the ‘Installing Applications’ dialog.

 

 Figure 3 The Installing Applications dialog

5. Click the Yes button. The installation program starts to download files and configure the HPC. The ‘Application
Downloading Complete’ dialog appears at the end of the installation procedure.

 

 Figure 4 The Application Downloading Complete dialog

6. Click the OK button. Now  you are ready to use Nokia Card Phone with the HPC.
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Using the Nokia Card Phone software

Monitor

The Monitor window enables you to:

− monitor the status of the card phone.

− switch the card phone on or off.

− change the card phone settings.

− enter the security codes the card phone requires before it can be used.

The Monitor window opens automatically when the card phone is inserted into the PC Card slot of the HPC. It can also
be opened by clicking the Start button, pointing to Programs and clicking Card Phone Monitor. The Monitor window
closes automatically when the card phone is removed. You can also close it by clicking the cross at the top-right
corner of the window.

The Monitor window is shown in the following figure:

Figure 5 Monitor main window

At the top of the window is the command bar. The command bar includes a menu bar and three toolbar buttons. The
toolbar buttons from left to right are: Power On/Off, Hangup and Settings. You can find the same functions also from
the menu.

Below the command bar is the network status information. The indicator bars next to the antenna figure show the
current signal strength. The name of the GSM operator is shown under them.

The card phone status information is shown in the middle of the window. The phone status can be one of the
following:

− Power down: The card phone is switched off.

− No SIM: The card phone is switched on but the SIM card is not inserted.

− Data/Fax call to/from number ? : A data or fax call is active. The remote phone number is displayed
if the number can be identified.

The status line is empty if the card phone is switched on but there are no active calls.
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Switching on the card phone

Initially the card phone is switched off after it has been inserted into the HPC. You can switch it on by clicking the
Power On/Off button in the toolbar or by selecting the Power Up command from the File menu. After this, the phone
possibly queries security codes before it can be used (see Security code requests).

Card phone can be switched off by clicking the Power On/Off button in the toolbar or by selecting the Power Down
command from the File menu. It is recommended that the card phone should be switched off before removing it from
the HPC.

When the HPC enters the suspend mode, the card phone is automatically switched off. Restoring power and
reconnecting must be done manually.

Security code requests

If the PIN code or security code request is set on, the code is asked each time the card phone is switched on. If a
wrong PIN code is given too many times, you are asked to key in the PUK code. When the PUK code is being asked,
you also have to give a new PIN code and confirm it (PIN code is 4 - 8 digits). Note: If a wrong PUK code is given too
many times, the SIM card will be destroyed. The PUK code request window is shown below.

Figure 6 The PUK Code request window

Hangup

You can end active calls by clicking the Hangup button in the toolbar or by selecting the Hang Up command from the
File menu.

GSM Settings

The basic card phone settings can be changed in the GSM Settings window. You can open this window by clicking the
Settings button in the toolbar or by selecting the GSM Settings command from the Tools menu.
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Figure 7 The GSM Settings window

In the GSM Settings window, the PIN and security code requests can be turned on or off. If you want to change these
settings, the corresponding codes must be given before the settings are actually changed.

Also the operator selection is made in this window. You can select the automatic selection or select the operator
manually in the drop-down list box in which all the currently detected operators are shown.

Data and fax applications

The Nokia Card Phone can be used as a normal fax modem to contact host computers or faxes. Select “Nokia Card
Phone” or “PC Card Modem” as the modem in each application. The card phone must also be switched on. Sending and
receiving short messages is not possible when there are active data or fax calls.

For bSquare bFAX application, init string “AT&FX0E0” should be used, the support for FAX class 1 should be disabled
and the hardware flow control should be enabled.

Short Message Service

Short messages can be sent and received by using the standard Windows CE Inbox application. Sending and receiving
short messages is not possible during calls.

Installation for Windows CE 2.0

To install the support for short message service in Windows CE 2.0 Inbox the following steps must be executed:

1. Start Inbox.

2. Choose Compose-Options... from the Inbox menu.

3. In the Services tab, click Add...

4. Select Short Message Service from the list that appears and type a name for the service.

5. Set the Short Message Service parameters using the dialog that appears (see 0).

6. Close open dialogs.

7. Select Service-Connect from the Inbox menu. Inbox must always be connected before messages can be sent or
read.

8. Now the Short Message Service is configured and you can start using it. Short messages are sent and received
very much like normal e-mail messages. Refer to the Inbox documentation for information about the Inbox
functionality.
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Installation for Windows CE 2.11

To install the support for Short Message Service in Windows CE 2.11 Inbox, follow these steps:

1. Start Inbox.

2. Choose Services-Options... from the Inbox menu.

3. In the Services tab, click Add...

4. Select Short Message Service from the list box that appears, and type a name for the service.

5. Set the short message service parameters using the dialog that appears (see The Short Message Service settings).

6. Close open dialogs.

7. Select Services-Connect from the Inbox menu. Inbox must always be connected before messages can be sent or
read.

The Short Message Service is now configured and you can start using it. Short messages are sent and received very
much like normal e-mail messages. Refer to the Inbox documentation for information about the Inbox functionality.

Receiving short messages

When the card phone receives a short message, a notification window is displayed (Figure 8). You can then retrieve
the messages from the card phone by selecting Service-Refresh Inbox menu command in CE 2.0 or Services-
Send/Receive Mail in CE 2.11 when connected. Note: Windows CE 2.0 Inbox shows all the messages read from the
phone as unread even if they have been read.

Figure 8 Short message received indication

Sending short messages

Sending, forwarding and replying to short messages is done in the normal way. For more information, refer to the
Inbox documentation. There are, however, some exceptions:

− The maximum length of a short message is 160 characters. The subject of the message is included in the
message.

− The To field must contain the recipient’s phone number. The recipient’s phone number can be in the
international or national format. For example: +35840123456 or 040123456. Any non-digit characters
are ignored (except + as the first character).

− If there are several recipients in the To field, the message will only be sent to the first recipient. Other
recipients are ignored.

− Mail attachments are ignored and not sent.
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The Short Message Service settings

The short message settings can be changed by selecting Inbox-Properties... menu command in Inbox. The following
dialog opens:

Figure 9 Short Message Service settings

Message Centre Number - Short messages are always first sent to a Short Message Service Centre (SMSC) run by a
network operator. The SMSC then forwards the messages to the recipient. If the recipient is not immediately available,
the message is stored in the SMSC until the recipient is available or until the validity period of the message has
expired. Note: The message centre number must given in the international format. For example: +35840123456.

Sending Format - You can request the network to convert the sent short messages into voice, text, fax, X.400, paging,
e-mail, telex or ERMES formats. In order to receive a converted message, the recipient must have an appropriate
terminal device available. This service may not be available on every network.

Validity Period -  This network service allows you to set the time that your short messages are stored at the message
centre while attempts are made to deliver it.

Provide Reply Path – This network service allows the recipient of your short message to reply to you using your short
message centre number.
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Troubleshooting

Here are symptoms and possible solutions for some basic problems concerning the installation and use of the Nokia
Card Phone software.

Generally, one or more of the following actions should help in most problems:

− Close all the programs which are using the card phone.

− Remove and reinsert the card phone.

− Reset the device.

− Reinstall the card phone software.

Not enough memory for installation.
There is not enough memory on the HPC for Nokia Card Phone software.
Unnecessary software should be removed or more memory should be allocated for the program files using
Control Panel System Properties.

Monitor displays the message “Card Phone not responding” and closes.
Open the Monitor window again by clicking the Start button, pointing to Programs and clicking Card Phone
Monitor.

Problems with Monitor.
An error message is displayed and the Monitor window closes. There is a problem in the connection with the
card phone. Try the actions listed at the beginning of the Troubleshooting section.

Card phone is not available for data and fax applications or does not work correctly.
Make sure that the card phone is powered up using the Monitor and that no other program is currently using
the card phone.

You can also try the actions listed at the beginning of the Troubleshooting section.
The card phone loses the network connection after the GSM Settings dialog is opened.

Make sure you have enabled the automatic operator selection or manually selected the correct operator. After
this, the operator should be re-detected after a short while.

Monitor shows zero signal strength but the name of the operator is still displayed.
Either the signal strength is very low or the Monitor has not yet received the signal strength information from
the card phone. Signal strength should be displayed correctly after a short while.

The HPC stops responding after the card phone is removed from the PC Card slot.
It is recommended that you switch off the card phone before removing it from the PC Card slot.

Inbox displays the message “Cannot communicate with the Card Phone”.
This usually happens if you use the Connect or Refresh commands in Inbox right after the card phone has been
powered up. You should wait a few seconds and try again.
This can also happen if a new short message is received at the same time as Inbox is checking the messages in
the phone. Use the Connect or Refresh commands.
If this error message appears when you are sending a short message, you should check that the Short Message
Centre number is correct.
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Important safety information

Traffic Safety

Do not use the Nokia Card Phone while driving a vehicle. If using the phone park the vehicle before conversing.

The use of an alert device to operate a vehicle’s lights or horn on public roads is not permitted.
Remember road safety always comes first!

Operating Environment

Remember to follow any special regulations in force in any area and always power down your phone whenever it is
forbidden to use it, or when it may cause interference or danger.

When connecting the phone or any accessory to another device, read its user’s guide for detailed safety instructions.
Do not connect incompatible products.

Electronic Devices

Most modern electronic equipment is shielded from radio frequency (RF) signals.  However, certain electronic
equipment may not be shielded against the RF signals from your wireless phone.

Pacemakers   Pacemaker manufacturers recommend that a minimum separation of 20 cm (6 inches) be maintained
between a wireless phone and a pacemaker to avoid potential interference with the pacemaker. These
recommendations are consistent with the independent research by and recommendations of Wireless Technology
Research.  Persons with pacemakers:

• Should always keep the phone more than 20 cm (6 inches) from their pacemaker when the phone is switched on;
• Should not carry the phone in a breast pocket;
• If you have any reason to suspect that interference is taking place, power down your phone immediately.
Hearing Aids  Some digital wireless phones may interfere with some hearing aids.  In the event of such interference,
you may want to consult your service provider.

Other Medical Devices  Operation of any radio transmitting equipment, including cellular phones, may interfere with
the functionality of inadequately protected medical devices. Consult a physician or the manufacturer of the medical
device to determine if they are adequately shielded from external RF energy or if you have any questions.  Power down
your phone in health care facilities when any regulations posted in these areas instruct you to do so.  Hospitals or
health care facilities may be using equipment that could be sensitive to external RF energy.

Vehicles  RF signals may affect improperly installed or inadequately shielded electronic systems in motor vehicles (e.g.
electronic fuel injection systems, electronic anti-skid (anti-lock) braking systems, electronic speed control systems, air
bag systems).  Check with the manufacturer or its representative regarding your vehicle.  You should also consult the
manufacturer of any equipment that has been added to your vehicle.

Posted Facilities  Power down your phone in any facility where posted notices so require.

Potentially Explosive Atmospheres

Power down your phone when in any area with a potentially explosive atmosphere and obey all signs and instructions.
Sparks in such areas could cause an explosion or fire resulting in bodily injury or even death.

Users are advised to power down the phone when at a refuelling point (service station). Users are reminded of the
need to observe restrictions on the use of radio equipment in fuel depots (fuel storage and distribution areas),
chemical plants or where blasting operations are in progress.

Areas with a potentially explosive atmosphere are often but not always clearly marked.  They include below deck on
boats; chemical transfer or storage facilities; vehicles using liquefied petroleum gas (such as propane or butane); areas
where the air contains chemicals or particles, such as grain, dust or metal powders; and any other area where you
would normally be advised to turn off your vehicle engine.
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Vehicles

Only qualified personnel should service the phone. Faulty service may be dangerous and may invalidate any warranty
which may apply to the unit.

Check regularly that all wireless phone equipment in your vehicle is mounted and operating properly.

Do not store or carry flammable liquids, gases or explosive materials in the same compartment as the phone, its parts
or accessories.

For vehicles equipped with an air bag, remember that an air bag inflates with great force.  Do not place objects,
including both installed or portable wireless equipment in the area over the air bag or in the air bag deployment area.
If in-vehicle wireless equipment is improperly installed and the air bag inflates, serious injury could result.

Power down your phone before boarding an aircraft. The use of wireless telephones in an aircraft may be dangerous to
the operation of the aircraft, disrupt the wireless telephone network and may be illegal.

Failure to observe these instructions may lead to suspension or denial of  telephone services to the offender, or legal
action or both.



16

Care and maintenance

Your phone is a product of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfill any warranty obligations and to enjoy this product for many years. When using your phone OR
any accessory:

Keep it and all its parts and accessories out of small children’s reach.

Keep it dry. Precipitation, humidity and  liquids contain minerals that will corrode electronic circuits.

Do not use or store it in dusty, dirty areas. Its moving parts can be damaged.

Do not store it in hot areas. High temperatures can shorten the life of electronic devices, damage batteries, and warp
or melt certain plastics.

Do not store it in cold areas. When the phone warms up (to its normal temperature), moisture can form inside the
phone, which may damage electronic circuit boards.

Do not attempt to open it. Non-expert handling of the device may damage it.

Do not drop, knock or shake it. Rough handling can break internal circuit boards.

Do not use harsh chemicals, cleaning solvents, or strong detergents to clean it. Wipe it with a soft cloth slightly
dampened in a mild soap-and-water solution.

Do not paint it. Paint can clog the device’s moving parts and prevent proper operation.

Use only the supplied or an approved replacement antenna.  Unauthorised antennas, modifications or attachments
could damage the phone and may violate regulations governing radio devices.

If the phone or any accessory is not working properly, take it to your nearest qualified service facility.  The personnel
there will assist you and, if necessary, arrange for service.


